
Avid® Editing Application 
ReadMe for Media Composer® v2019.12

IMPORTANT: Avid periodically makes software updates available for download on 
Avid.com at the following location:www.avid.com/us/support/downloads. Please 
check the above site regularly for information on available downloads for your 
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation was 
published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.

http://www.avid.com/support/downloads
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, recommendations, and 
strong suggestions.

c A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. Follow the 
guidelines in this document or on the unit itself when handling electrical 
equipment.

n A user tip provides a helpful hint that can aid users in getting the most from their 
system.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 

n A shortcut shows the user keyboard or mouse shortcuts for a procedure or 
command.

> This symbol indicates menu commands (and subcommands) in the order you 
select them. For example, File > Import means to open the File menu and then 
select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list indicate 
that you perform one of the actions listed.

(Windows), (Windows 
only), (macOS), or (macOS 
only)

This text indicates that the information applies only to the specified operating 
system, either Windows or macOS.

Bold font Bold font is primarily used in task instructions to identify user interface items and 
keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the mouse 
action. For example, Command+Option+C or Ctrl+drag.

 | (pipe character) The pipe character is used in some Avid product names, such as MediaCentral | 
Production Management. In this document, the pipe is used in product names 
when they are in headings or at their first use in text.

Symbol or Convention Meaning or Action

http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
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that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Media Composer Notes

n (Windows) If you are installing the editing application and you have a previous version of the 
editor on your system, go to the Control Panel and manually uninstall the editing application 
before you try and install v2019.12.

c Media Composer v2019.12 is not supported with Media Composer | Cloud Remote.

c MCDEV-11537 If you intend to use full-frame stereoscopic with an Avid Artist DNxIQ, you 
may want to remain with Media Composer v2018.12.x until the issues with Stereoscopic 
support are resolved in a future version.

c (Mac) You might receive an “Is not optimized for your Mac” message while launching 
Media Composer for the first time on a Mac OS 10.14.x system. Press OK to continue.

• (MCCET- 2541) When working with Avid Artist DNxIO or Avid Artist DNxIQ, you should 
disable the Line In recording input (BlackMagic Audio in the Windows OS).

• Avid recommends that you do not install Desktop Video software version 10.10.1 on Media 
Composer versions prior to v2018.5.1.

• Avid Artist DNxIO and Avid Artist DNxIQ: If you are using Avid Artist DNxIO, Avid 
Artist DNxIQ, or a BlackMagic Designs video device, please update to Desktop Video 
software version v11.0 or higher. If you are using Avid Artist DNxIV and Avid Artist DNxIP 
please update to AJA software v15.2 or later.

• Qualified Operating Systems: For information on qualified operating systems, see 
Qualified Hardware and Operating Systems.

• Dongle Info (Mac Only): The Dongle Sentinel driver installer is no longer automatically 
installed when you install the editing application. The driver is now located in the 
Avid_Utilities folder (/Applications/Utilities/Avid_Utilities/Sentinel_Driver). If you have a 
dongle, manually install the driver from this location. 

c When installing the Sentinel Driver,  check your System Preferences and select “Security 
and Privacy.” You may need to choose to Allow the driver to be accessed.

http://www.avid.com/onlinesupport
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• NVIDIA drivers are no longer included with the Media Composer installer. You must access 
the Nvidia website - Nvidia.com to download the applicable driver. See the Compatibility 
Chart for tested driver version with this release.

• NVIDIA Driver:

Avid recommends that if you are on a Windows 7 system and working with the Nvidia 
driver, you should enable desktop composition. See this article for details:

http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Window
s-7

• MCDEV-11537 If you intend to use full-frame stereoscopic with an Avid Artist DNxIQ, you 
may want to remain with Media Composer 2018.12 until the issues with stereoscopic 
support are resolved in a future version.

Changed in Media Composer v2019.12

The following has changed in Media Composer v2019.12.

NVIDIA Driver Support

Avid supports NVIDIA driver v441.28. Reminder: Avid no longer includes the driver with our 
installer. You must go to the Nvidia website to download the driver.

Interplay Production Support 

This release includes support for Interplay Production v2019.6 components and requires 
upgrading to 2019.6 Media Indexer as described in “Upgrading Media Indexer to 2019.6” in the 
following document. 
http://resources.avid.com/SupportFiles/attach/ReadMe_Interplay_Production_V2019_6.pdf

Note: On Mac systems, you must manually uninstall Media Indexer before installing v2019.6. 
For details on uninstalling Media Indexer on a Mac system, see “Uninstalling Media Indexer 
from a Mac OS X System” in the following document:

http://resources.avid.com/SupportFiles/attach/Interplay_Install_SW_Guide_V2018_11.pdf

https://www.nvidia.com/Download/index.aspx?lang=en-us
http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7
http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7
http://resources.avid.com/SupportFiles/attach/ReadMe_Interplay_Production_V2019_6.pdf
http://resources.avid.com/SupportFiles/attach/Interplay_Install_SW_Guide_V2018_11.pdf
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Fixed in Media Composer v2019.12

The following have been fixed: 

➤ Bug Number: MCCET-3285. With connected IO hardware such as AJA or Blackmagic, you 
could not downscale monitor output on an HD client monitor.

➤ Bug Number: MCDEV-11345. When tools were tabbed with the Composer Window, the video 
displayed on top of the tools.

➤ Bug Number: MCCET-3374. Bin sifting was not retained after closing and opening the bin.

➤ Bug Number: MCDEV-12014. Sometimes when the Audio Mixer was layered over another 
tool or bin, and the Timeline or Composer had focus, hovering the mouse over the Audio Mixer 
made the Audio Mixer the active window.

➤ Bug Number: MCDEV-12015. Minimizing Media Composer on dual monitors with auto hide 
sometimes resulted in losing Menus, Workspace Bar, and background host panel.

➤ Bug Number: MCCET-3210. The Source Record monitor would go black, and menus stopped 
working if you were working with the Source Browser and the Windows taskbar was set to 
auto-hide.

➤ Bug Number: MCDEV-12099. Thumbnails for subclips were recaching every time you opened 
a bin in Frame View, slowing performance.

➤ Bug Number: MCDEV-12347. With large projects on shared storage, updating the project after 
changing a bin name was slow.

➤ Bug Number: MCCET-3257. (macOS). When waveforms were enabled, clicking in the 
Timeline might have resulted in a crash and Breakpad error.

➤ Bug Number: MCCET-3345. (macOS) In some instances, after performing a lasso and trim, the 
Source monitor would display black.

➤ Bug Number: MCCET-3171. (macOS v10.12.6). Media Composer was not populating the 
second screen on a dual monitor setup.

➤ Bug Number: MCCET-3305. You might have received a “Cannot find bin x in Project x” when 
performing a Find Bin. 

➤ Bug Number: MCCET-3108. The text to identify locked bins was not displayed in bold. 
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➤ Bug Number: MCCET-3299. Using JKL did not work properly when playing a clip with a 
Timewarp effect.

➤ Bug Number: MCCET-3355. Imported tga files were only one frame in duration.

➤ Bug Number: MCCET-3304. Newly created bins that were empty did not save size nor position 
when working with shared storage.

➤ Bug Number: MCCET-3206. In some instances, clip frames would rebuild on the entire 
sequence.

➤ Bug Number: MCCET-3388. You could not resize an effect +/- 10 steps using the keyboard 
shortcuts.

➤ Bug Number: MCCET-3369. French, Swedish, German, and Danish letters in Bin Script View 
comment field didn’t display properly.

➤ Bug Number: MCCET-3333. Sequential Targa (.tga) files could not be imported correctly.

➤ Bug Number: MCCET-3337. When right-clicking on linked clips in a bin, the Relink to Files 
option might have been grayed out.

➤ Bug Number: MCCET-3404. (NRCS Tool) When browsing iNews database, the cursor 
continued showing a spinning wheel even after the result had been returned.

➤ Bug Number: MCCET-3292. A Transition did not play correctly in full quality if the first clip 
was an imported still image with XDCAM HD or AVC Long GOP.

➤ Bug Number: MCCET-3399. The position info did not display even if you selected Settings > 
Grid > Display > Show Position Info.

➤ Bug Number: MCCET-3372. Media Composer became unresponsive when you tried to 
perform a transfer to a Transfer service that was not available.

➤ Bug Number: MCCET-3342. If Waveforms were enabled, the Timeline responsiveness lagged 
when dragging or trimming.

➤ Bug Number: MCCET-2817. Trimming a clip with an AudioSuite Time 
compression/expansion effect might have affected subsequent renders.

➤ Bug Number: MCCET-3251. In some instances Media Composer vaporized when extracting a 
segment.
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➤ Bug Number: MCCET-3330 (Avid Artist DNxIO, Avid Artist DNxIQ). In some instances, 
720p25 projects were incorrectly converted to 1080i50.

➤ Bug Number: MCCET-3250. (macOS) In some instances, when editing keyframes and then 
entering Trim mode, the Source Record monitor would appear black.

➤ Bug Number: MCCET-3230. Timecode Burn-in added pulldown frame info when added to V5 
or V6 track.

➤ Bug Number: MCCET-3306. In some instances, if the Effects Editor was open, Color 
Correction was not always added correctly and the wrong clip was modified.

Limitations

➤ Bug Number:  MCDEV-12338. Playback of ProRes RAW material on Windows systems using 
an AMD graphic card requires AMD driver 2639.5 or earlier. Media Composer will not decode 
ProRes Raw linked material with newer drivers such as 2906.10 or 2841.5.

➤ Bug Number:  . Some fonts, by their design, are available only in Bold. On the Mac system it 
can happen that selecting a font does not produce any visual changes. Try selecting “Bold.”

➤ Bug Number: DEFI-1808. (Media Composer | Distributed Processing) Two clips or sequences 
will always be created when performing a consolidate or transcode with Media Composer | 
Distributed Processing.

➤ Bug Number: MCDEV-11481. Promoting a title from the Title Tool application to Avid Titler+ 
cannot be performed if it includes a motion adapter. 

➤ Bug Number: MCCET-11796. Larger than 10 bit DPX files might fail to link correctly.

Workaround:  Go to File > Settings and click the User tab. In the Link Settings, click the Link 
Options tab and make sure Alpha Channel is set to Ignore.

➤ Bug Number: MCDEV-11430. Media Tool ignores the “Current project” filtering option and 
lists media files that are not associated with the current project. 

➤ Bug Number: . If you launch a project and receive an “Enable 3rd Party Emulation” warning, 
even if you select Enable in the warning dialog, you should also perform the following: Select 
File > Settings and click the Project tab. Click General Settings and select “Enable Bin Sharing 
on 3rd party storage emulating Avid NEXIS/ISIS.”
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➤ Bug Number: MCDEV-11197. In some instances, the Interleave option might not appear in the 
Export As dialog box. If you are performing an Export using the Avid Media Processor, the 
Interleave option should appear when you choose Stereo, 5:1, or 7.1 Audio.

Workaround:  If it does not appear, briefly toggle back to the Mono setting, then toggle to 
Stereo Mix once again. Doing so should reveal the Interleave option.

➤ Bug Number: MCDEV-8641. (AMD Graphics). Systems with AMD graphics cards might 
display tearing when performing Full Screen playback.

➤ Bug Number: MCDEV-9460. Windows 7 systems with Nvidia Maxwell or Nvidia Pascal cards 
might experience playback issues that could result in “Play Consumer timeout” errors.

Workaround:  Select “Disable GPU Effects” in the Render Settings dialog box.

➤ Bug Number: MCDEV-9269. (Media Composer | Cloud) After performing a remote download 
operation on a sequence containing AVC-I 100 remote media, the downloaded media appears as 
XAVC-I 100.

Workaround:  Download the entire master clips.

➤ Bug Number: (Mac).  You may occasionally see the menu bar flash followed by a brief beach 
ball. To fix this, deactivate “Displays have separate spaces” under System Preferences > Mission 
Control settings. 

➤ Bug Number: MCDEV-9011. Intermittently, when working with the XDCAM Nablet Plug-in, 
you might see “Failed to get the sample position from the AMA Plug-in” errors if you have 
waveforms enabled in the Timeline. 

➤ Bug Number: COGS-2560. While working in the Script Window, text operations 
(cut/copy/paste/delete/editing) can only be done in edit mode. See “Editing a Script” in the Help. 

➤ Bug Number: MCDEV-5650.  When working with Panasonic LongG media, you might receive 
an “SFPlayConsumer Timeout” error if audio waveforms are enabled.

Workaround:  Turn off audio waveforms.

➤ Bug Number: MCDEV-5385. MultiCam editing with Panasonic LongG media is not supported 
with this release.
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Before Installing the Editing Application
Media Composer | Enterprise and Media Composer | Distributed Processing

If you are working with Media Composer | Enterprise or Media Composer | Distributed 
Processing, please refer to the “Installation Prerequisites” section in the Media Composer | 
Enterprise Administration Guide and Media Composer | Distributed Processing Administration 
Guide to make sure you have compatible Avid MediaCentral Cloud UX Platform ISO and Avid 
MediaCentral Cloud UX Feature Pack ISO versions.

Avid DX Driver Separate Installer

The Avid DX Driver is not automatically installed when you install the editing application. If 
you need to install the Avid DX Driver to work with your Avid IO device, you can install it 
separately. 

The installer is located:

• (Mac) /Applications/Utilities/Avid Utilities

• (Windows) Program Files\Avid\Utilities\DXDrivers

n For Windows systems, there is a Win7 driver and a Win10 driver in the Utilities folder. The Win7 
driver works for both Windows 7 and Windows 8 systems.

Before Installing the Editing Application in an Avid Interplay Environment

c Please note the following before you install the editing application in an Avid Interplay or 
Avid MediaCentral environment.

Carefully read through the “Avid Editor Compatibility with Interplay Releases” guide (found in 
the following link) before upgrading. It might be necessary to also upgrade the Interplay 
components on the editing client. 
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing 
application on a system with less than 8GB RAM, you will receive a buffer error and installation 
will not proceed.

Sentinel Error Message

(MCDEV-2394) On a Windows 7 system, if a “Failed to add Sentinel64.cat file.” error appears 
during the installation, you can safely click OK to continue with the installation. Dongle 
activation will work properly.

http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
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Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the 
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it 
from that location. 

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you 
must give the user the right to “Increase Scheduling Priority.” This must be done within the 
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving 
the right to a group and adding the user to that group. You will not be able to launch as a regular 
user if this is not set properly.

If you are part of a domain, a Domain Administrator should install and perform the first launch 
of the editing application.

Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a 
Shared Storage environment, mount your workspaces as an Administrator. You may then log off 
and log back in as a Standard user, if necessary.

After Installing the Editing Application
AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are 
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start 
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install 
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background 
Services” in the Help.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.
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Minimum RAM Recommendation

For this release Avid recommends 16 GB minimum, 32 GB recommended. Some features might 
require more RAM and specific hardware. See “Feature Performance” on page 29 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 29 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the 
Open IO Frequently Asked Questions document on the Knowledge Base: 
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following lists the qualified Operating Systems. Depending upon your hardware the 
qualified Operating Systems are:

• Windows v7 64-bit SP1(Professional) and Windows v8.1 (Professional and Enterprise), 
Windows v10 64-bit v1809 or later (Professional and Enterprise).

n Windows v10 64-bit v1909 is not currently supported.

• Macintosh v10.12.6, 10.13.6, 10.14.6

n With the release of Mac OS v10.13.x and higher, Apple requires manual approval of loading 
Kernel Extensions (KEXTs). (For example Avid Nitris DX, BlackMagic, and AJA IO devices 
install Kernel Extensions.) At installation time, you should get a dialog saying that the KEXT 
was not loaded. You must go the “Security & Privacy” system preference and manually approve 
the KEXT. Keep the Security & Privacy pane open after you install the I/O device drivers so that 
you will see the notice that the driver has been blocked and press the “allow” button within 30 
minutes of installing or the driver will be permanently blocked. 

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing 
applications.

Qualified PC Workstations with Avid Media Composer

The following PC Workstations are qualified with Avid Media Composer.

n Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

http://avid.force.com/pkb/articles/en_US/faq/en422991
http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart
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Qualified PC Hardware Graphics Card Supported with 

HP Z2 G4 3.0 Ghz or higher six core i7/Xeon E3 
Tower or SFF
8 to 64 GB DDR4-2666 memory

Nvidia P620, 
P1000, P2000 AMD 
WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 3630 3.0 Ghz or higher six core i7/Xeon E3 
Tower 8 to 64 GB DDR4-2666 memory

Nvidia P1000, 
P2000 AMD 
WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 3430 3.0 Ghz or higher six core i7/Xeon E3 
SFF 8 to 64 GB DDR4-2666 memory

Nvidia P1000

AMD WX4100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 3930 3.0 Ghz or higher six core i7/Xeon E3 
1U Rack 8 to 64 GB DDR4-2666 memory 
Thunderbolt adapter not supported

Nvidia P1000, 
P2000 AMD 
WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Lenovo P330 3.0 Ghz or higher six core i7/Xeon 
E3 Tower or SFF 8 to 64 GB DDR4-2666 
memory

Nvidia P600 P1000 
P2000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Lenovo P330 Tiny 2.9 Ghz six core i7-8700T
8 to 64 GB DDR4-2666 memory – 1 option slot 
– TB or discrete graphics

Nvidia P600 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

HP Z2 G4 Mini 3.0 Ghz or higher six core 
i7/Xeon E3
8 to 32 GB 2666Mhz DDR4 Memory. 
Performance model only Thunderbolt option.

Nvidia P600, P1000 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified Hardware and Operating Systems

14

HP Z8 G4 Dual [8 - 24 core 2.1 Ghz or higher] 
scalable

64-128 GB DDR4-2666 memory, Tower

Nvidia P4000, 
P5000, P6000

AMD WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

HP Z6 G4 Dual [8 -24 core 2.1 Ghz or higher]   
Intel Scalable Processors
64 to 192GB DDR4-2666 memory

Nvidia P4000, 
P5000, 
AMDWX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

HP Z4 G4 6 - 10 core or 18 core 3.3 Ghz or 
higher processor

32-128 GB DDR4-2666 memory, Tower

Nvidia P2000, 
P4000

AMD 
WX5100,WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 7920 Dual (8-24 core 2.1 GHz or higher) 
Intel Scalable Processors Tower
64 to 128 GB DDR4-2666 memory

Nvidia P4000 
P5000 P6000 
AMD WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell R7920 Dual (8-24 core 2.1 GHz or higher) 
Intel Scalable Processors Rack
64 to 128 GB DDR4-2666 memory
Thunderbolt adapter not supported in Rack 7920

Nvidia P4000 
P5000 P6000 
AMD WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 7820 Dual (8-24 core 2.1 GHz or higher) 
Intel Scalable Processors
64 to 128 GB DDR4-2666 memory

Nvidia P4000 
P5000 AMD 
WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Dell 5820 6, 8 or 10 core 3.3 Ghz or higher
Intel W-Processors
32 to 128 GB DDR4-2666 memory

Nvidia P600, P1000 
P2000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Qualified PC Hardware Graphics Card Supported with 
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Lenovo P920 Dual [8 -28 core 2.1 Ghz or 
higher]   Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

Nvidia P4000 
P5000, P6000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

HP Z1 G3 All-in-one 3 3.4 Ghz or higher quad 
core i7/Xeon E3
8 or 16 GB DDR3-1600 Memory

Nvidia M1000M, 
M2000M

HP Z240 3.0 Ghz or higher quad core i7/Xeon 
E3 8 to 64 GB DDR4-2400 memory Tower or 
SFF

Nvidia K1200 
(SFF), P2000 
(Tower)

Intel P630

Software Only

HP Z2 Mini 3.0 Ghz or higher quad core 
i7/Xeon E3 8 to 32 GB 2400Mhz DDR4 
Memory, USB-C 

Nvidia M620, 
HD530, HD630

Software Only

Dell 3620 3.0 Ghz or higher quad core i7/Xeon 
E3 8/16/32 GB DDR4-2400 memory Tower

Nvidia M2000, 
M4000

Intel P630

Software Only

Dell 3420 3.0 Ghz or higher quad core i7/Xeon 
E3 8/16/32 GB DDR4-2400 memory SFF

Nvidia K620, 
K1200

Intel P630

Software Only

Dell 5720 AIO 3.3 Ghz or higher quad core 
i7/Xeon E3 3840x2160 - 8 to 64 GB 2400Mhz 
DDR4 Memory, thunderbolt 3/USB-C

AMD WX4150 Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Lenovo P720 Dual [8 -28 core 2.1 Ghz or 
higher]   Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

NvidiaP2000, 
P4000 P5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Lenovo P520/P520C 6, 8, 10 or 18core 2.3 Ghz 
or higher]   Intel W-Processors
32 to 128 GB DDR4-2666 memory

Nvidia P1000, 
P2000 P4000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxID
Avid Artist DNxIP

Qualified PC Hardware Graphics Card Supported with 
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Lenovo P320 3.0 Ghz or higher quad core 
i7/Xeon E3 8/16/32 GB DDR4-2400 memory 
Tower or SFF

Nvidia P600, 
P1000, 
P2000(Tower)

Intel P630

Software Only

Lenovo P320 Tiny 2.9 GHz quad core i7-7700T Nvidia P600 Software Only

HP Z840 Dual [8 - 16 core 2.1 Ghz or higher] 
Intel V4 32/64 GB DDR4 2400 memory

Nvidia P4000, 
P5000, P6000, 
M4000, M5000, 
M6000

AMD W7100, 
WX7100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

HP Z640 Dual 10, 12, 16 core 2.1 Ghz or 
higher] Intel V4 32/64 GB DDR4-2400 memory 

Nvidia P4000, 
P5000, P6000 
M2000, M4000 
M5000, M6000

AMDW5100, 
W7100, W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Dell 7910 Dual [8 - 16 core 2.1 Ghz or higher]

Intel V4 32/64 GB DDR4-2400 memory

Nvidia M4000, 
M5000, M6000

AMD W7100, 
W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Dell R7910 Dual [8 - 16 core 2.1 Ghz or higher]

Intel V4 32/64 GB DDR4-2400 memory

Nvidia M4000, 
M5000, M6000

AMD W7100, 
W8100

Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ 

Dell 7810 Dual [8-16 core 2.1 Ghz or higher]

Intel V4 32/64 GB DDR4-2400 memory

Nvidia M2000, 
M4000, M5000

AMD W5100W, 
W7100, W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Qualified PC Hardware Graphics Card Supported with 
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Dell 5810 [6 or 8 core 3.0 Ghz or higher] Intel 
V4 16/32/64 GB DDR4- 2400 memory 

Nvidia M2000

AMD W5100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P910 Dual [8 - 16 core 2.1 Ghz or 
higher] Intel V4 32/64 GB DDR4-2400 memory

Nvidia M4000, 
M5000, M6000

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P710 Dual [8 - 16 core 2.1 Ghz or 
higher] Intel V4 32/64 GB DDR4-2400 memory

Nvidia M2000, 
M4000, M5000

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

HP Z440 [6 or 8 core 3.0 Ghz or higher] Intel 
V4 16/32/64 GB DDR4- 2400 memory

Nvidia P2000, 
M2000

AMD W5100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P510 6 or 8 core 3.0 Ghz or higher Intel 
V4 16/32/64 GB DDR4- 2400 memory

Nvidia M2000, 
K1200 

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P410 6 or 8 core 3.0 Ghz or higher Intel 
V4 16/32/64 GB DDR4- 2400 memory

Nvidia P2000, 
P1000
M2000, K1200 

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Qualified PC Hardware Graphics Card Supported with 
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HP Z840 Dual 8, 10 or 12 core Intel V3 2.3 Ghz 
or higher Onboard NIC supported for ISIS 32 or 
64 GB DDR4- 2133 memory

Nvidia K4200, 
K5200, M4000, 
M5000, M6000

AMD W7100, 
W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

HP Z640 Dual 8, 10 or 12 core Intel V3 2.3 Ghz 
or higher 32/64 GB DDR4-2133 Memory

Nvidia K2200, 
K4200, K5200, 
M4000, M5000

AMD, W5100, 
W7100, W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Dell R7910 Dual 8,10 or 12 Core Intel V3 
2.3 Ghz or higher Onboard NIC supported for 
ISIS 32 or 64 GB DDR4- 2133 memory

Nvidia K4200, 
K5200, M4000, 
M5000, M6000

AMD W7100, 
W8100

Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Dell 7910 Dual 8, 10 or 12 core Intel V3 2.3 Ghz 
or higher - Onboard NIC supported for ISIS 32 
or 64 GB DDR4- 2133 memory

Nvidia K4200, 
K5200, M4000, 
M5000, M6000

AMD W7100, 
W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Dell 7810 Dual 8, 10 or 12 core Intel V3 2.3 Ghz 
or higher - Onboard NIC supported for ISIS 32 
or 64 GB DDR4- 2133 memory

Nvidia K2200, 
K4200, K5200, 
M4000, M5000

AMD W5100, 
W7100, W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P900 Dual 8, 10 or 12 core Intel V3 2.3 
Ghz or higher - Onboard NIC supported for ISIS 
32 or 64 GB DDR4- 2133 memory

Nvidia K4200, 
K5200, M4000, 
M5000, M6000

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Qualified PC Hardware Graphics Card Supported with 
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Lenovo P700 Dual 8, 10 or 12 core Intel V3 
2.3 Ghz or higher - Onboard NIC supported for 
ISIS 
32 or 64 GB DDR4- 2133 memory

Nvidia, K2200 
K4200, K5200, 
M4000, M5000

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

HP Z240 Tower and SFF (Small Form Factor) 
Quad Xeon E3- 1245V5 3.5 Ghz
Onboard NIC supported for ISIS 
8/16/32 GB DDR4- 2133 Memory

Nvidia K620, 
K1200

K2200, HD530

Software Only

Lenovo P310 Tower and SFF (Small Form 
Factor) Quad Xeon E3- 1245V5 3.5 Ghz
Onboard NIC supported for ISIS 
8/16/32 GB DDR4- 2133 Memory

Nvidia K620, 
K1200

K2200 
HD530

Software Only

Dell 3620 quad Xeon E3-1245V5 3.5 Ghz
Onboard NIC supported for ISIS 8/16/32 GB 
DDR4- 2133 Memory

Nvidia K620, 
K2200

HD530

Software Only

Dell 3420 SFF (Small Form Factor) Quad Xeon 
E3-1245V5 3.5 Ghz
Onboard NIC supported for ISIS 
8/16/32 GB DDR4- 2133 Memory

Nvidia K620, 
K1200

HD530

Software Only

Dell 5810 6-core or 8 core Intel V3 3.0 Ghz or 
higher
Onboard NIC supported for ISIS
16 or 32 GB DDR4- 2133 memory

Nvidia K2200

AMD W5100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P500 6-core or 8 core Intel V3 3.0 Ghz 
or higher
Onboard NIC supported for ISIS
16 or 32 GB DDR4- 2133 memory

Nvidia K2200 Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Lenovo P300 Tower and SFF (Small Form 
Factor) Quad-Core E3- 1246v3 3.5 Ghz CPU
8 or 16 GB DDR3-1600 Memory

Intel HD 4600

Nvidia K600, K620

Software Only

Qualified PC Hardware Graphics Card Supported with 
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Qualified PC Notebooks for Avid Media Composer

The following PC Notebooks are qualified with Avid Media Composer. The following applies to 
the editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

HP Z1 G2 All-in-one E3- 1245V3 3.4 Ghz CPU
8 or 16 GB DDR3-1600 Memory

Intel HD 4600

Nvidia K2100M, 
K3100M, K4100M

Mojo DX

Lenovo ThinkCentre Edge 93Z i7-4770S quad 
core 3.1 Ghz 
8 or 16 GB DDR3-1600 memory

Intel HD 4600 Software Only

Qualified PC Hardware Graphics Card Supported with 

Qualified PC Notebooks Graphics Cards Supported With

HP Zbook Studio G5 and Studio X360 G5 2.6 
Ghz or higher six core i7/Xeon E3 Ultrabook
8 to 32 GB 2667Mhz DDR4 Memory 
Dream Color option
HP Thunderbolt dock G2

Nvidia P1000 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 5530 15" 2.6Ghz or higher 6 core i7/Xeon 
E3
Thin and light
8 to 32 GB 2667Mhz DDR4 Memory 
USB 3.0 to Ethernet required for Avid NEXIS 
Connectivity

NvidiaP1000 
P2000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo P1 15” 2.6 Ghz or higher six core 
i7/Xeon E3 Thin and Light
8 to 64 GB 2667Mhz DDR4 Memory

Nvidia P1000 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
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HP Zbook 17" G5 2.6 Ghz or higher six core 
i7/Xeon E3

Nvidia P3200, 
P4200, P5200 
AMD WX4170

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 7730 17" 2.6Ghz or higher 6 core i7/Xeon 
E3
8 to 64 GB 2667Mhz DDR4 Memory

NvidiaP3200
P4200 P5200
AMD WX4170

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo P72 2.6 Ghz or higher six core i7/Xeon 
E3
8 to 64 GB 2667Mhz DDR4 Memory

Nvidia P3200, 
P4200, P5200

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 15" G5 2.6 Ghz or higher six core 
i7/Xeon E3
8 to 64 GB 2667Mhz DDR4 Memory 
Dreamcolor option

Nvidia P1000, 
P2000

AMD WX4150

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 15V G5 2.6 Ghz or higher six core 
i7/Xeon E3
HP Thunderbolt dock G2

Nvidia P1000 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 7530 15" 2.6Ghz or higher 6 core i7/Xeon 
E3
8 to 64 GB 2667Mhz DDR4 Memory

NvidiaP1000 
P2000
AMD WX4150

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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Dell 3530 15" 2.6Ghz or higher 6 core i7/Xeon 
E3
8 to 32 GB 2667Mhz DDR4 Memory

NvidiaP600 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo P52 2.6 Ghz or higher six core i7/Xeon 
E3
8 to 64 GB 2667Mhz DDR4 Memory

Nvidia P1000, 
P2000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 17" G4 2.8 Ghz or higher quad core 
i7/Xeon E3
HP Thunderbolt dock G2

Nvidia
P3000
P4000
P5000
AMD
WX4170

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 15" G4 2.8 Ghz or higher quad core 
i7/Xeon E3
HP Thunderbolt dock G2

Nvidia
M620
M1200
M2200
AMD WX4150

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook Studio Ultrabook G4 2.8 Ghz or 
higher quad core i7/Xeon E3
HP Thunderbolt dock G2

Nvidia
M1200

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 7720 17" 2.6 Ghz or higher quad core 
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to 
64 GB 2400Mhz DDR4 Memory, thunderbolt 3

Nvidia P3000, 
P4000, P5000

AMD Radeon 
WX4150, WX7100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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Dell 7520 15" 2.6 Ghz or higher quad core 
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to 
64 GB 2400Mhz DDR4 Memory, thunderbolt 3

Nvidia M1200, 
M2200

AMD Radeon 
WX4130, WX4150

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 5520 15" 2.8 Ghz or higher quad core 
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to 
32 GB 2400Mhz DDR4 Memory Thunderbolt 3

Nvidia M1200 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 3520 15" 2.8 Ghz or higher quad core 
i7/Xeon E3 1920x1080 - 8 to 32 GB 2400Mhz 
DDR4 Memory - Thunderbolt 3

Nvidia

M620 

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo P51 2.6 Ghz or higher quad core 
i7/Xeon E3
8 to 64 GB 2400Mhz DDR4 Memory

Nvidia M1200, 
M2200

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo P71 2.6 Ghz or higher quad core 
i7/Xeon E3
8 to 64 GB 2400Mhz DDR4 Memory

Nvidia P3000, 
P4000, P5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook Studio Ultrabook 2.6 Ghz or higher 
quad core i7/Xeon E3
8 to 32 GB 2133Mhz DDR4

Nvidia M1000M Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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HP Zbook 15" G3 2.6 Ghz or higher Quad core 
i7/Xeon E3 1920x1080 or 3840x2160- 8 to 64 
GB 2133Mhz DDR4 Memory, thunderbolt 3

Nvidia M1000M, 

M2000M, M600M 

AMD, W5170M

Intel HD 530, P530, 
P580

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 17" G3 2.6Ghz or higher quad core

i7/Xeon E3

Nvidia M3000M, 
M4000M, M5000M

AMD W6150M

Intel HD 530, P530, 
P580

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 7710 17" 2.7 Ghz quad core i7 or 2.9 Ghz 
Xeon E3 1920x1080 or 3840x2160 - 8/16/32 
GB 2133Mhz DDR4L Memory

Nvidia M3000M, 
M4000M, M5000M

AMD W7170M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 7510 15" 2.5 Ghz and higher quad core i7 
1920x1080 or 3200x1800 - 8/16/32 GB 
2133Mhz DDR4L Memory

Nvidia M1000M, 
M2000M

AMD W5170M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 5510 15" 2.3 Ghz and higher quad core i7 
1920x1080 or 3840x2160 - 8/16 GB 2133Mhz 
DDR4L Memory   USB-C

Nvidia M1000M Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell 3510 15" 2.3 Ghz and higher quad core i7 
1920x1080  - 8/16 GB 2133Mhz DDR4L 
Memory

AMD W5130M Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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Lenovo P70 2.6 Ghz or higher quad core 
i7/Xeon E3 
1920x1080 or 3840x2160 - 8 to 64 GB 
2133Mhz DDR4, Memory, thunderbolt 3

Nvidia M3000M, 
M4000M, M5000M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Mojo DX

Lenovo P50 2.6 Ghz or higher quad core 
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to 64 
GB 2133Mhz DDR4 Memory, thunderbolt 3

Nvidia M1000M, 
M2000M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 17" G2 - 2.5 Ghz and higher quad 
core i7 1920x1080 - 8/16/32 GB 1600Mhz 
DDR3 Memory thunderbolt

Nvidia K3100M 
K4100M, K2200M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 15" G2 - 2.5 Ghz and higher quad 
core i7 1920x1080 or 3200x1800 screen 
resolution 8/16/32 GB 1600Mhz DDR3L 
Memory Thunderbolt

Nvidia K1100M, 
K2100M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell M6800 17" 2.5 Ghz and higher quad core 
i7 1920x1080 - 8/16/32 GB 1600Mhz DDR3 
Memory

Nvidia K2200M, 
K3100M, K4100M 
K5100M

Software Only
Mojo DX

Dell M4800 15" 2.5 Ghz and higher quad core 
i7 1920x1080 or 3200x1800 - 8/16/32 GB 
1600Mhz DDR3 Memory

Nvidia K1100M, 
K2100M

Software Only
Mojo DX

Dell M3800 15" 2.3 Ghz and higher quad core 
i7 1920x1080 8/16/32 GB 1600Mhz DDR3 
Memory 

Nvidia K1100M Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With
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Qualified Macintosh Workstations for Avid Media Composer

The following Macintosh Workstations are qualified with the Avid Media Composer. 

n Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Lenovo W541 15" 2.5 Ghz and higher quad 
core i7 15" 1920x1080 2880x1620 - 8/16/32 
GB 1600Mhz DDR3 Memory Thunderbolt

Nvidia K1100M, 
K2100M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified PC Notebooks Graphics Cards Supported With

Qualified Macintosh Hardware Graphics Cards Supported With

iMac Retina 5K 27” 3.6 GHz 8-core Intel i9
16 to 64GB 2666MHz DDR4

March 2019

AMD Radeon Pro 
575x, 580x, Vega 48

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

iMac Retina 4K 21.5” 3.2 GHz 6-core Intel i7
16 to 32 GB 2666 MH DDR4

March 2019

AMD Radeon Pro 
560x Vega 20

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mac mini 3.2 Ghz 6- core Intel i7 
8 to 64 GB 2666 Mhz DDR4 Memory

Late 2018

Intel UHD 630 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

iMac Pro 5K  27" 3.2 Ghz i7 8 core
3.0 Ghz i7 10 core
2.5 Ghz i7 14 core
2.3 Ghz i7 18 core

Late 2017 - 32 to 128GB 2666 Mhz DDR4
NOTE: 10Gb Ethernect requires Avid NEXIS 
Pro client v2018.3.

Radeon Pro Vega 56, 
64

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart
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iMac Retina 5K  27" 4.2 Ghz i7 Quad core

Mid 2017 - 8 to 64 GB 2400 Mhz DDR4

Radeon Pro 570, 575, 
580

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

iMac Retina 4K  21.5" 3.6 Ghz i7 Quad core

Mid 2017 - 8 to 32 GB 2400Mhz DDR4

Radeon Pro 555, 560 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

iMac Retina 5K 27" 4.0 Ghz i7 Quad core 
Late 2015 - 8/16/32 GB 1867Mhz DDR3

Radeon M390, M395, 
M395X

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

iMac Retina 4K 21.5" 3.3 Ghz i7 Quad core 
Late 2015 - 8/16/32 GB 1867Mhz DDR3

Intel Iris Pro 6200 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP
Mojo DX

iMac Retina 5K 27" 4.0 Ghz i7 Quad core 
Late 2014 - 8/16/32 GB 1600Mhz DDR3

Radeon M290X, 
M295X

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP
Mojo DX

Mac Pro 6 core 3.5 Ghz, 8 core 3.0 Ghz, 12 
core 2.7 (Late 2013) 16/32 GB 1866Mhz 
DDR3 Memory Thunderbolt - no PCI-e slots

Dual AMD
FirePro D300, D500, 
D700

Mojo DX 
Nitris DX (no HD capture)
Artist DNxIO 
Artist DNxIQ
Artist DNxIV
Artist DNxID
Avid Artist DNxIP

Qualified Macintosh Hardware Graphics Cards Supported With
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Qualified Macintosh Notebooks for Media Composer

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

Qualified Macintosh Notebook Graphics Cards Supported With

MacBook Pro 15" 2.2 Ghz and higher i7/i9 six 
core Mid 2018 - Touch Bar & Thunderbolt 3

UHD630 AMD 
Radeon Pro 555X, 
560X

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

MacBook Pro 13" 2.7 Ghz quad core Intel core 
i7 Mid 2018 - Touch Bar & Thunderbolt 3
8 to 16 GB 2133Mhz LPDDR3 Memory

Touch Bar not used by MC

Intel Iris Plus 655 Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

MacBook Pro 15" 2.8 Ghz and higher i7 quad 
core Mid 2017 - Touch Bar & Thunderbolt 3 
16 GB 2133Mhz

LPDDR3 Memory

Touch Bar not used by MC

HD630 
AMD
Radeon 
Pro 555, 560

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

MacBook Pro 15" 2.6 Ghz and higher i7 quad 
core Late 2016 - Touch Bar & Thunderbolt 3 
16 GB 2133Mhz DDR4 Memory

Touch Bar not used by MC

HD530 
AMD
Radeon 
450,455, 460

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

MacBook Pro 15" 2.2 Ghz and higher i7 quad 
core Mid 2015

Retina & Thunderbolt 16 GB 1600Mhz 
DDR3L Memory

HD5000 
AMD
Radeon 
M370X

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. For a list of the 
qualified systems, see Qualified Workstations and Laptops. 

MacBook Pro 15" 2.3 Ghz and higher i7 quad 
core Retina Late 2013 and Mid 2014 8 or 16 
GB 1600Mhz DDR3L Memory

Nvidia
GeForce 
GT 750M
& Intel HD5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified Macintosh Notebook Graphics Cards Supported With

Feature Description Recommended System

16K projects 64GB RAM minimum

Editing High Resolution, 
High Frame Rate XAVC-I 
Media (UHD/4k in 
59.94p) 
4 streams of media and 
color adapters

64 GB RAM minimum, 96 GB 
recommended Dell 7920

Dell 7820

• Dual Xeon Gold 6154 3.0 Ghz, turbo 
up to 3.7 Ghz 18-core (72 cores with 
Hyperthreading) 

• AMD WX-7100

Storage: 10Gb Ethernet Avid NEXIS

1080p/50 XAVC Long 
Baseband Capture 

16 GB RAM minimum Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading
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Editing High Resolution, 
High Frame Rate DNxHR 
Media (UHD/4k in 
59.94p) 

16 GB RAM minimum, 32 GB 
recommended

HP Z840/Z820
HP Z640/Z620
Dell 7920/7910/ T7610
Dell 7820/7810/T5610
Lenovo P910/P900/
Lenovo P710/P700

• NVIDIA P5000, M5000 or K5200 
and AMD WX-7100
PCIe Gen3 Gfx card (recommended)

Mac Pro

• 12 core (24 with Hyperthreading) 
3 GHz

• Dual AMD FirePro 500/700 Graphics 
card

Storage: 10Gb Ethernet Avid NEXIS

Editing High Resolution 
Media (Higher than 2K+)

16 GB RAM minimum Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

DMF and Background 
Transcode, Background 
Render

32 GB RAM recommended Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Media Composer | Cloud 16GB RAM minimum. 24 GB or 
higher recommended depending 
upon system model.

i7 Quad core or higher with 
Hyperthreading

J2K Capture Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

XDCAM Long GOP 
9-way MultiCam with 
high stream count 
sequences

Avid recommends 16 GB RAM Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Feature Description Recommended System
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Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

Qualified systems

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage.

Qualified PC Dual 6 Core or higher 

Qualified Mac Pro 6 core or higher, 12 
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance. 
you will get better performance 
with higher end workstations.

Qualified Xeon Workstations

NOTE: RED plug-in uses the Graphics 
Processor. Better performance with high 
performance graphics cards.

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance.

Recommendation of qualified systems 
depends on your planned use of this 
feature. Heavy usage of highly 
compressed codecs requires the high end 
systems. (Dual 6 Core or Dual 8 Core 
systems)

AVCI-Intra Capture AVC-Intra capture with software 
codecs is supported.

24 core and higher Windows systems 
only.
Note: If problems are encountered, please 
use a Nitris DX w/AVC-I capabilities or 
ingest at another resolution like DNxHD 
and transcode to AVC I. 

Feature Description Recommended System
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Avid Artist I/O Device Compatibility

The following table shows the minimum version Media Composer supported with the Avid 
Artist I/O devices.

You must download the appropriate Avid Artist software from your Avid Master Account.

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage, 
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the 
Avid editing applications. You can also refer to Documentation and version matrix.

AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

AMA Workflows: Dual Quad, Dual 6 or 
Dual 8 core systems

Feature Description Recommended System

Device
Minimum supported version Media 
Composer

Avid Artist | DNxIO Media Composer v8.4.1 and higher

Avid Artist | DNxIQ Media Composerv8.8.3 and higher

Avid Artist | DNxIV Media Composer v8.10 and higher

Avid Artist | DNxIP Media Composer v2018.8

Avid Artist | DNxID Media Composer v2018.9

http://avid.force.com/pkb/articles/en_US/compatibility/en267087
https://my.avid.com/account/orientation
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IMPORTANT: For information on third party support (for example, Sorenson, Boris, 
etc) see the third party’s web site.

Item Versions Comments

QuickTime Support v7.7.9 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

Note: QuickTime is not supported with 
Windows 10.

Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

Avid Interplay 
Support

See Knowledge Base article on 
compatibility.

IMPORTANT: The Avid Interplay 
components that get installed on the 
editing application must be updated to 
the Avid Interplay version that is released 
with the editing application. These 
include the Media Indexer, Interplay 
Access, Interplay Framework, Interplay 
Transfer Client and ProEncode Client. 
The Avid Interplay Server components 
can remain on the previous releases listed 
as supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” doc on the 
Knowledge Base.

NVIDIA Driver 
Support

 v431.02 See “Setting up the NVIDIA Card” on 
page 38.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

Shared Storage 
Support

Avid NEXIS and Avid ISIS®. See “Shared Storage Support” on 
page 39.

Sony XDCAM driver v2.13 (XDCAM Transfer for 
Macintosh)

Windows FAM v2.3.2 and VFAM 
v5.0.2

The VFAM firmware version for 
PDW-U1 is 2.600. 
The PDW-U2 is 2.810. 
The driver can be downloaded from 
Sony's website http://esupport.sony.com/.

http://www.microsoft.com/en/us/default.aspx
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
http://esupport.sony.com/


Avid Editing Application Compatibility with Pro Tools

34

Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10 
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no 
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first 
uninstall option - “Pro Tools Only” - which is not selected by default.

• Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be 
connected in a co-install configuration for use with Pro Tools 10.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application.

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Panasonic P2 drive (Macintosh) v3.1.7

(Windows) v2.24

There is currently no P2 writeback 
support for Macintosh clients.

Avid Artist Series 
(Euphonix)

EuControl software v3.4 See the User’s Guide for information on 
Artist Series Color setup information.

Item Versions Comments
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Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Avid Mbox 2 Family Audio Devices

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install
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Other Avid Audio Devices

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only)

• Command|8

• Avid Artist Control

• Avid Artist Mix

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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• Avid Artist Transport

• Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC only)

Command|
8

Avid 
Artist 
Control

Avid 
Artist Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation 
gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable
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For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. See the “Compatibility 
Chart” on page 32 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Nvidia website 
- Nvidia.com.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Download the applicable Nvidia driver from the Nvidia website - Nvidia.com.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel.

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.

Feature
Digi 002 
(MC only)

Command|
8

Avid 
Artist 
Control

Avid 
Artist Mix

Avid Artist 
Transport

Avid Artist 
Color

https://www.nvidia.com/Download/index.aspx?lang=en-us
https://www.nvidia.com/Download/index.aspx?lang=en-us
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To set the Driver for Avid Editing Environments

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

3. Click the Global Setting tab.

4. Under Global presets, select Base Profile.

5. Scroll to locate the Power Management Mode. Select Prefer maximum performance.

6. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

For information on Shared Storage Support, see the Avid NEXIS and Avid ISIS tables in the 
following document:

http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf

http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2019 Avid Technology, Inc. and its licensors. All rights reserved.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, 
Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and 
all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or 
other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility 
for Avid products. All other trademarks are the property of their respective owners.  For a full list of Avid trademarks, see: 
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 

Avid Media Composer ReadMe • Created 12/20/19

http://www.avid.com/US/about-avid/legal-notices/patent-marking
http://www.avid.com/en/legal/trademarks-and-other-notices
http://www.avid.com/en/legal/trademarks-and-other-notices
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